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Basic Printing 3

Basic Printing

Before you start, make sure your printer is set up and its software is installed as 
described on the Start Here sheet. If you’re using Windows NT® 4.x, see page 10 
for instructions on installing the software.

Loading Paper

1. Open the output tray and its extension.

2. Fan the stack of paper and place it against the right edge of the slot. Don’t 
push the paper in.

3. Press in the side of the left edge guide and slide it against the paper (but not 
too tightly).

Follow these guidelines when loading paper:

■ Don’t load paper above the arrow on the left edge guide.

■ Load the printable side face-up. It’s often brighter or whiter than the
other side.

■ Always load the short edge first, even when printing in landscape mode.

■ Load letterhead or preprinted paper into the printer top edge first.

Load paper 
under the tab

Press here, 
then slide over

Download from Www.Somanuals.com. All Manuals Search And Download.



4 Basic Printing

Printing in Windows

1. From the File menu, click Print. You see a Print window like this one:

2. Make sure Epson Stylus C86 Series is selected.

3. Click the Properties or Preferences button. (If you see a Setup, Printer, or 
Options button, click it. Then click Properties or Preferences on the
next screen.)

4. Select the following in the properties window:

Click here to 
open your printer 
software

Select your printer here

Select the type 
of document 
you’re printing

Select your 
paper Type

Select your 
paper Size

Select your 
document or 
image orientation
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Printing in Windows 5

5. Select from these Quality Option settings:

 Draft: For rough drafts with reduced print quality

 Text: For text-only documents with higher text quality

 Text & Image: For documents with text and images with higher quality

 Photo: For photos and graphics with good quality and speed

 Best Photo: For photos or graphics with high print quality

Note: 

For more information about printer settings, click the ? or Help button.

The Quality Option settings on this screen give you the best combination of quality 
and speed for most prints. For instructions on printing at the highest quality (Photo 
RPM), see page 14.

6. Select the paper Type for the paper you’re using. 

7. Select other settings as shown on page 4, then click OK.

8. At the Print window, click OK or Print to start printing.

During printing, this window appears and shows the progress of your print job. 
You can use the buttons to cancel, pause, or resume printing. You can also see how 
much ink you have left.

Tip: 

You can also cancel printing by pressing the  paper button on your printer.

Click to cancel printing

Click to pause or 
resume printing
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6 Basic Printing

Printing with Macintosh OS X

If you’re using an OS X compatible printing application, follow the steps below to 
print a document. (If you’re using an application that’s compatible only with 
Macintosh® Classic mode, follow the steps on page 8 instead.)

Before you begin, make sure you added your printer to the Print Center as 
described on the Start Here sheet.

1. From the File menu, choose Page Setup and select the following settings:

2. After you select your settings, click OK.

3. From the File menu select Print. You see a window like this one:

4. Open the Printer pull-down list, and select your printer again. Always check 
to make sure you selected the same printer you chose in the Page Setup 
window.

5. Select Print Settings from the pull-down list.

Select your printer 
from the list

Select your Paper Size

Select your document 
or image orientation

Select Print Settings 
from the list

Select your printer 
from the list
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Printing with Macintosh OS X 7

6. Select the following Print Settings as necessary:

Note: 

For more information about printer settings, click the ? or Help button.

The Quality setting on this screen gives you the best combination of quality and 
print speed for most prints. For instructions on printing at the highest quality (Photo 
RPM), see page 17.

7. Choose other settings as necessary, then click Print.

8. To monitor the progress of your job, click the  Print Center icon when it 
appears in the dock on the bottom of your desktop. Double-click Stylus C86 
in the Printer List window. 

You can click the print job, then cancel, hold, or resume printing.

Note: 

You can also cancel printing by pressing the  Paper button on your printer.

9. When you’re finished, close Print Center.

Select the type of 
paper you’re using

Select Color or 
Black ink

Select higher 
quality or faster 
printing (if available)

Click Print
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8 Basic Printing

Printing with Macintosh OS 9

Before you begin, make sure you selected your printer in the Chooser as described 
on the Start Here sheet.

1. From the File menu, select Page Setup. Select the following settings:

2. After you choose your settings, click OK.

3. From the File menu, select Print.

4. Select the following print settings as necessary:

Note: 

For more information about printer settings, click the ? button.

The Quality setting on this screen gives you the best combination of quality and 
print speed for most prints. For instructions on printing at the highest quality (Photo 
RPM), see page 20.

Make sure you see C86 Series

Select your paper size

Select your document 
or image orientation

Select higher quality or faster printing (if available)

Select the type of 
paper you’re using

Select Automatic mode

Select Color or 
Black ink
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Printing with Macintosh OS 9 9

5. You can also do the following:

■ Click  to reduce or enlarge your image, print multiple layouts, or add a 
watermark.

■ Click  to turn on background printing.

■ Click  to change the Print button to Preview. You can then click it to 
preview your printout.

■ Click  to check your ink levels.

6. Click Print.

7. If you turned on background printing, you can select Epson Monitor IV 
from the Application menu in the upper right corner of your screen. You see 
the Epson Monitor window:

Note: 

If you’re not using background printing and you need to cancel printing, hold down 
the key and press the . (period) key. Or press the  paper button on the 
printer.

Select your print 
job, then click here 
to cancel printing

Click to check 
ink levels

Click here to show or 
hide the print settings
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10 Basic Printing

Installing Printer Software for 
Windows NT 4.x

Before you begin, complete the instructions on the Start Here sheet for setting up 
your printer. For instructions on installing printer software in Windows® XP, Me, 
2000, 98, or on a Macintosh, see your Start Here sheet. 

Note: 

Use a parallel cable to connect the printer to your computer. Windows NT 4.x does not 
support a USB connection. 

1. Turn on your computer. (Make sure your printer is still on.) 

2. Put the Epson CD-ROM in your drive.

3. Read the license agreement and click Agree to continue with the installation. 

4. When you see the Options Menu, click Install Printer Driver. Wait while the 
files are copied to your computer. 

5. Click OK when you see a message that setup is complete. 

6. Click Install Printer User’s Guide and follow the on-screen instructions. 

7. Click Share Photos Online and follow the instructions to install a link to 
the Epson Photo Center.SM

8. Click Explore Photo Projects Online and follow the instructions to install a 
link to the Epson Print Lab.SM

9. Click Exit. When you see the Epson Product Registration screen, register your 
printer as instructed. 

10. Remove the CD-ROM and restart your computer. 

Note: 

Epson Software Film Factory does not support Windows NT 4.x. 

You’re ready to start printing! See the instructions beginning on page 3. 
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Printing Photos 11

Printing Photos 

You can print beautiful snapshots and enlargements with or without white 
borders. 

See the section on loading paper, below, then see one of the following sections for 
instructions on printing photos in Windows or Macintosh.

Loading Paper

Here are the recommended papers and sizes for printing photos: 

Note: 

You can print beautiful photographs on many other types of Epson paper; however, 
those listed above support borderless printing.

With proper care, photographs from your Epson Stylus® printer will last for many 
years. The special Epson DURABrite inks designed for your printer are 
formulated to achieve improved lightfastness when used with Epson papers for 
prints that are properly displayed or stored. For best results, always use Epson 
papers.

Paper name Sizes

Paper Type or Media 

Type setting

Epson DURABrite Ink 
Glossy Photo Paper

4 × 6
Letter (8.5 × 11 inches)

DURABrite Ink Glossy 
Photo Paper

Epson Matte Paper 
Heavyweight

8 × 10
Letter (8.5 × 11 inches) 

Matte Paper - 
Heavyweight

Epson Photo Paper 4 × 6
A4 (8.3 × 11.7 inches)
Letter (8.5 × 11 inches)

Glossy Photo Paper

Epson Glossy Photo Paper 4 × 6
Letter (8.5 × 11 inches)
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12 Printing Photos

As with traditional photos, Epson recommends proper care that will minimize 
color changes and lengthen display life: 

■ Frame prints under glass or a protective plastic sleeve to protect them from 
atmospheric contaminants like humidity, smoke, and high levels of ozone.

■ As with all photographs, keep your prints away from direct sunlight.

■ For proper storage, keep your prints in a photo album or plastic photo storage 
box in acid-free, archival sleeves commonly available from most camera stores.

■ Always keep unused paper in the original package. 

To order Epson paper, contact your dealer or call the Epson StoreSM at 
(800) 873-7766 or visit our web site at www.epsonstore.com (U.S. sales only). 
In Canada please call (800) 463-7766 for dealer referral.

Load paper as shown: 

■ Always load the short edge first, even for printing landscape-oriented photos.

■ Load the printable side face-up. It’s usually whiter or brighter than the other 
side.

■ Make sure the paper is under the tabs on the left and right edge guides. 

■ Check the paper package for additional loading and printing instructions. 

Insert paper against the right edge

Slide the left 
edge guide 
against the paper
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Printing Photos in Windows

1. Start your photo program and open your photo file.

2. Open the File menu and click Print. 

Make sure your printer is selected, then click Properties or Preferences. (If 
you see a Setup, Printer, or Options button, click it. Then click Properties 
or Preferences on the next screen.)

You see a window like this one:

3. Select Photo or Best Photo as the Quality Option setting.

4. Select the paper Type for the paper you’re using.

5. For pictures without white borders, click the Borderless checkbox. Read the 
message and click OK.

6. Select your paper Size setting. 

7. Select Portrait or Landscape as the orientation setting.

8. Do one of the following:

■ Click OK, then click OK or Print. 

■ If you want to print at the highest resolution possible, or use special 
settings, continue with the steps in the next section.

Select Photo or 
Best Photo

Click here for 
photos without 
white borders
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14 Printing Photos

Customizing Your Photo Settings

1. On the Main tab, click the Advanced button in the bottom right corner of 
the window. If you see a warning note, click Continue.

2. Select the following advanced settings as necessary:

Note: 

For the highest print quality, select Photo RPM. Please note that printing will take 
longer in this mode. 

3. Once you’ve finished selecting advanced settings, you can:

■ Click OK to save your settings, return to the Print window, and print.

■ Click the Basic button to return to the Basic settings.

■ Click the Page Layout tab and continue with step 4 to select layout 
options.

Select a color management method
(To choose No Color Adjustment, click ICM first)

Click here to select 
Photo RPM (5760 × 
720) for the best 
print quality on 
certain paper types

Select Print Options 
as necessary
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Printing Photos in Windows 15

4. Select the following page layout settings as necessary:

Note: 

Some layout settings may not be available, depending on other settings you 
choose.

5. Select image position or resizing options as necessary. These affect only your 
printed image, and are not available for borderless printing.

6. If you’re printing borderless photos, you can adjust the Expansion slider to 
choose Min, Max, or the in-between setting. 

Min retains the entire image in your print, but there may be a small white 
edge on the borders of the print. Max expands the image to ensure that there 
are no unprinted edges, but the edges of the image may not appear in the 
print. 

7. Click OK to save your settings, then click OK or Print.

Select image 
resizing 
options here

Select image 
position 
options here

Select 
borderless 
printing 
options here
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16 Printing Photos

Printing Photos on Macintosh OS X

1. Start your photo program and open your photo file.

2. From the File menu select Page Setup. You see a window like this one:

3. For pictures without white borders, select Stylus C86(Sheet Feeder - 
Borderless) in the Format for pull-down list.

4. Select your Paper Size.

5. Select  portrait or  landscape as the orientation setting.

6. Click OK.

7. Open the File menu and click Print. You see a window like this one:

Select Stylus C86(Sheet Feeder - 
Borderless for photos without 
white borders

Select Print 
Settings from 
the list

Select Stylus C86 
(Sheet Feeder - 
Borderless for photos 
without white borders
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Printing Photos on Macintosh OS X 17

8. For pictures without white borders, select Stylus C86(Sheet Feeder - 
Borderless) in the Printer pull-down list.

9. Select Print Settings from the list.

10. Select the Media Type for the paper you’re using.

11. Select Quality (for higher quality) or Speed (for faster printing) using the 
slider.

12. Do one of the following:

■ Click Print.

■ If you want to print at a higher resolution or use special settings, continue 
with the steps in the next section.

Customizing Your Photo Settings

1. Click Advanced.

2. Select these advanced settings as necessary:

Note: 

For the highest print quality, select Photo RPM. Please note that printing will take 
longer in this mode.

For color management 
settings, select Color 
Management from the list

Click here to select Photo RPM 
(5760 × 720) for the best print 
quality on certain paper types
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18 Printing Photos

3. If you’re printing photos without white borders, select Expansion from the 
pull-down list. You see a window like this one:

4. Adjust the Expansion slider to choose Min, Max, or the in-between setting.

Min retains the entire image in your print, but there may be a small white 
edge on the borders of the print. Max expands the image to ensure that there 
are no unprinted edges, but the edges of the image may not appear in the 
print. 

5. Click Print.

Printing Photos on Macintosh OS 9

1. Start your photo program and open your photo file.

2. From the File menu select Page Setup. You see a window like this one:

3. Select your Paper Size.

Click here for photos without white borders
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Printing Photos on Macintosh OS 9 19

4. For photos without white borders, click the Borderless checkbox. Read the 
message and click OK.

Click the Expansion button. You see a window like this one:

Adjust the Expansion slider to choose Min, Max, or the in-between setting. 

Min retains the entire image in your print, but there may be a small white 
edge on the borders of the print. Max expands the image to ensure that there 
are no unprinted edges, but the edges of the image may not appear in the 
print. Then click OK.

5. Select Portrait or Landscape as the orientation setting.

6. Click OK.

7. Open the File menu and click Print. You see a window like this one:

8. Select one of the Media Type for the paper you’re using.

9. Select Quality (for higher quality) or Speed (for faster printing) using the 
slider.

10. Do one of the following:

■ Click Print.

■ If you want to select special settings for color matching or printing at a 
higher resolution, continue with the steps in the next section.

Select the type of 
paper you’re using

Select higher 
quality or faster 
printing
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20 Printing Photos

Customizing Your Photo Settings

1. On the printer settings window, select Custom, then click Advanced.

2. Select these advanced settings as necessary:

Note: 

For the highest print quality, select Photo RPM. Please note that printing will take 
longer in this mode.

3. Click OK to save your settings, then click Print.

Select color 
management 
settings here

Select various print 
options here

Click here to select 
Photo RPM (5760 × 
720) for the best print 
quality on certain 
paper types
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Replacing Ink Cartridges 21

Replacing Ink Cartridges

When the red  ink light flashes, one or more ink cartridges are low on ink.

When the red  ink light stays on, you need to replace the cartridge(s).

When you print, you’ll also see a message on your screen telling you which 
cartridge is low or empty.

Purchasing Ink Cartridges

Use these Epson ink cartridges within six months of installing them and before the 
expiration date on the package.

* Availability of black ink cartridge types varies by location. 

To ensure good results, use genuine Epson ink cartridges and do not refill them. 
Other products may cause damage to your printer not covered by Epson’s 
warranty.

When you need new ink cartridges, contact your dealer, or call the Epson Store at 
(800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada, please 
call (800) 463-7766 for dealer referral.

Ink cartridge Part number 

Black (high capacity)* T043120

Black (standard capacity)* T044120

Cyan T044220

Magenta T044320

Yellow T044420

Color multipack 
(Cyan, Magenta, and Yellow) 

T044520
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22 Replacing Ink Cartridges

Ink Cartridge Precautions

Warning: 

Keep ink cartridges out of the reach of children.

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets in 
your eyes, flush them immediately with water.

Don’t remove the cartridge label, or ink will leak. 

Don’t remove the green IC chip from the cartridge. Installing a cartridge without an 
IC chip can damage the printer. Avoid touching the green IC chip, as this can 
damage the ink cartridge.

If you remove an ink cartridge temporarily, protect the ink supply port on the 
bottom of the cartridge from dirt and dust. Place it in a small box, or, if you have the 
original packaging, return it to its own box.

Store ink cartridges in the same environment as the printer. Stand the cartridges 
upright (the label identifying the color should be on top). 
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Removing and Installing Ink Cartridges

Be sure you have a new ink cartridge before you begin. Once you start replacing a 
cartridge, you must complete all the steps in one session.

1. Make sure the printer is turned on (the green  power light should be on, 
but not flashing). Then open the printer cover.

2. Press and release the  ink button. 

The print head moves to the left, and the cartridge that needs to be replaced 
stops under the  ink out mark. The  power light begins to flash. 

Caution: 

Don’t hold down the  ink button for more than 2 seconds, or the printer will start 
to clean the print head.

To avoid damaging the printer, never move the print head by hand.

3. Press the  ink button again.

■ If more than one cartridge is empty, the next cartridge moves under the 
 ink out mark.

■ If all the empty cartridges have been identified, the print head moves to 
the ink cartridge replacement position, as shown on the following page.
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24 Replacing Ink Cartridges

4. Open the cartridge cover.

5. Squeeze the back tab of the empty cartridge as you lift it out of the printer. 
Don’t take the used cartridge apart or try to refill it.

Warning: 

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets 
into your eyes, flush them immediately with water.
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Removing and Installing Ink Cartridges 25

6. Before you remove the new cartridge from its package, shake it four or five 
times.

7. Unwrap the new ink cartridge and lower it into the holder. Push down gently 
until the cartridge is firmly seated.

Caution: 

Don’t touch the green circuit board on the front of the cartridge; you may inhibit 
normal operation and printing.

8. If you need to replace other ink cartridges, repeat steps 5 through 7 before 
continuing with step 9.

Don’t touch 
the green part
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26 Replacing Ink Cartridges

9. Close the cartridge cover.

10. Close the printer cover and press the  ink button. The printer begins 
charging the ink delivery system.

The green power light flashes and the printer makes noise. Charging takes 
about half a minute. When it’s finished, the green power light stops 
flashing and stays on, and the red  light goes out.

Caution: 

Never turn off the printer while the green power light is flashing, unless the 
printer hasn’t moved or made noise for more than 5 minutes.
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Solving Problems

Checking the Printer’s Lights

Lights Explanation

Green power 
light flashes

The printer is receiving a print job, replacing an ink cartridge, 
charging ink, or cleaning the print head.

Red paper light 
is on

Your paper ran out. Load more paper, then press the 
paper button to resume printing. 

Red paper light 
flashes

Paper is jammed in the printer. Press the paper button to 
eject the paper. If that doesn’t work, turn off the printer, open 
the cover, and pull the paper out from the front, including any 
torn pieces. Then turn on the printer, reload paper, and press 
the paper button.

Red ink light 
flashes

One of the cartridges is low on ink. Check the message that 
appears on your screen to determine which cartridge is low. 
Make sure you have a replacement cartridge.

Red ink light 
is on

One of the cartridges is out of ink or not installed. Make sure 
you have a replacement cartridge, then follow the steps on 
page 23 to install it.

If you have just installed a new cartridge, it may be 
incompatible with the printer or incorrectly installed. Reinstall 
it or replace it with the correct cartridge.

Green power 
light and red ink 
light are on

An ink cartridge is not installed correctly. Reinstall it as 
described on page 25.

Red paper and 
ink lights flash 

alternately

Paper may be blocking movement of the print head. Turn off 
the printer, then open the cover and remove any jammed 
paper or other foreign objects. Turn the printer back on. If the 
lights are still on, contact your dealer or Epson as described 
on page 30.

Green power 
light is off; red 

paper and 
ink lights flash

The printer may have an internal error. Turn off the printer, 
wait a few seconds, and turn it on again. If the lights are still 
flashing, contact your dealer or Epson as described on 
page 30.
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Problems and Solutions

You see banding (light lines).

■ Make sure the paper Type or Media Type setting matches the paper you’re 
using.

■ The print head nozzles may need cleaning; follow the instructions below to 
clean the print head:

1. Make sure the printer is turned on but not printing, and the red  ink 
light is off. 

2. Windows: Right-click the  printer icon on your taskbar (in the lower 
right corner of your screen). Select Head Cleaning.

Note: 

If you don’t see the icon, go to your printer properties window as described on 
page 4, click the Maintenance tab, then select Head Cleaning.

Macintosh OS X: Open the Applications folder and select Epson Printer 
Utility. Select Stylus C86 in the printer list, click OK, and select Head 
Cleaning.

Macintosh OS 9: Open the File menu and choose Page Setup or Print. 
Click the  Utility button, then click the  Head Cleaning button.

3. Follow the instructions on the screen to clean the print head.

Cleaning takes several seconds. The printer makes noise and the green 
power light flashes.

Caution: 

Never turn off the printer while the green  power light is flashing, unless the 
printer hasn’t moved or made noise for more than 5 minutes.
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4. When the green  power light stops flashing, make sure paper is loaded 
in the printer, then do the following:

Windows: Click Print Nozzle Check Pattern. Then click Print. 

Macintosh: Click Confirmation, then click Next.

The nozzle check pattern prints.

5. If the nozzle check pattern has no gaps or white 
lines as shown, click Finish.

If the pattern has gaps, click Clean to clean the 
print head again.

You can also turn the printer off and wait 
overnight—this allows any dried ink to soften—
and then try cleaning the print head again.

■ The ink cartridges may need replacing; see page 21 for instructions.

Your printout is blurry or smeared.

■ Make sure the printable (whiter) side of the paper is face-up. 

■ Use Epson papers to ensure proper saturation and absorption of genuine 
Epson ink.

Your paper doesn’t feed correctly or jams in the printer.

■ If multiple pages feed at once, remove the paper from the sheet feeder, fan the 
edges to separate the sheets, then reload it.

■ If paper jams, press the  paper button for several seconds to clear the jam. 
If that doesn’t work, open the cover and pull the paper out from the front, 
including small pieces that may have torn off. Reload the paper and press the 

 paper button.

■ Heavily saturated prints may curl, causing a paper jam when printing on both 
sides of the paper.

■ Make sure you use new, smooth, high-quality paper, loaded printable side up. 
Don’t load paper above the arrow mark inside the left edge guide. Place the 
paper against the right edge, behind the tab. Slide the left edge guide against 
it, but not too tightly.
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Where To Get Help

Epson provides technical assistance 24 hours a day through the electronic 
support services and automated telephone services listed below. 

To speak to a technical support representative, dial:

■ U.S.: (562) 276-7525, 6 AM to 8 PM, Pacific Time, Monday through Friday 
and 7 AM to 4 PM, Saturday. 

■ Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through 
Friday.

Toll or long distance charges may apply. 

Please have the following information ready:

■ Product name (Epson Stylus C86)

■ Product serial number (located on the back of the printer)

■ Proof of purchase (such as a store receipt) and date of purchase

■ Computer configuration and operating system version

■ Description of the problem

You can purchase ink cartridges, paper, manuals, and accessories from the Epson 
Store at (800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In 
Canada, please call (800) 463-7766 for dealer referral. 

Service Access

World Wide 
Web

From the Internet, you can reach Epson Support at 
http://support.epson.com. At this site, you can download 
drivers and other files, look at product documentation, access 
troubleshooting information, and receive technical advice 
through e-mail.

Automated 
Telephone 
Services

A variety of automated help services are available 24 hours a day, 
seven days a week. To use these services, you must have a touch 
tone telephone and call (800) 922-8911. Your Epson SoundAdviceSM 
Express Code is 70535. Use this code to quickly select the Stylus C86 
in SoundAdvice.
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Requirements and Notices

Windows System Requirements

■ A Microsoft® Windows compatible PC with a Pentium®-equivalent processor 
(233 MHz or faster recommended)

■ Windows 98 SE, Windows Me, Windows 2000, Windows XP, or Windows NT 4.x

■ At least 64MB RAM (128MB recommended)

■ 100MB free hard disk space (200MB or more recommended)

■ VGA or better display adapter and monitor (SVGA for Windows XP)

■ CD-ROM or DVD drive for installing the printer software

■ Parallel connection: a high-speed, bidirectional IEEE-1284 compliant parallel cable, 
up to 10 feet long (3 meters); the cable must have a D-SUB, 25-pin, male connector 
for your computer, and a 36-pin, Centronics® compatible connector for the printer.

■ USB connection: a computer with preinstalled Windows 98 SE, Me, 2000, or XP, 
and a Windows-compliant USB port and shielded USB “AB” cable. Using an 
improperly shielded USB cable may cause the printer to malfunction. 

Macintosh System Requirements

■ An Apple® iMac™ series or Power Macintosh® G3 or G4 with a built-in USB port

■ Macintosh OS 9.1 or later, or OS X 10.1.3 or later

■ For Mac OS 9: 32MB RAM (64MB RAM recommended)
For Mac OS X: 128MB RAM (256MB recommended)

■ At least 100MB free hard disk space (200MB recommended)

■ VGA display or better

■ CD-ROM or DVD drive for installing the printer software.

■ A shielded USB “AB” cable. Using an improperly shielded USB cable may cause the 
printer to malfunction.
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Important Safety Instructions

Before using your printer, read these safety instructions to make sure you use it safely and 
effectively:

■ Be sure to follow all warnings and instructions marked on the printer.

■ Use only the type of power source indicated on the printer’s label.

■ Connect all equipment to properly grounded power outlets. Avoid using outlets on 
the same circuit as photocopiers or air control systems that regularly switch on and 
off. 

■ Place the printer near a wall outlet where the plug can be easily unplugged.
Placez l’imprimante près d’une prise de courant où la fiche peut être débranchée 
facilement.

■ Do not let the power cord become damaged or frayed. 

■ If you use an extension cord with the printer, make sure the total ampere rating of the 
devices plugged into the extension cord does not exceed the cord’s ampere rating. 
Also, make sure the total ampere rating of all devices plugged into the wall outlet does 
not exceed the outlet’s ampere rating.

■ Keep your printer and computer system away from potential sources of 
electromagnetic interference, such as loudspeakers or cordless telephone base units.

■ Avoid locations that are subject to rapid changes in heat or humidity, shocks or 
vibrations, or dust.

■ Leave enough room around the printer for sufficient ventilation, leaving at least 
3.9 inches between the back of the printer and the wall.

■ Do not place the printer near a radiator or heating vent or in direct sunlight.

■ Place the printer on a flat, stable surface that extends beyond the printer base in all 
directions. The printer will not operate properly if it is tilted or at an angle.

■ When transporting or storing the printer, don’t tilt it, stand it on its side, or turn it 
upside-down. This may allow ink to leak from the ink cartridges.

■ Turn off and unplug the printer before cleaning. Clean with a damp cloth only. Do 
not spill liquid on the printer.

Caution: Always turn the printer off using the  power button. Don’t switch off the 
power strip or unplug the printer until the green  power light is off.

■ Do not block or cover the openings in the printer’s case or insert objects through the 
slots. 

■ Except as specifically explained in this manual, do not attempt to service the printer 
yourself. 
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■ Unplug the printer and refer servicing to qualified service personnel under the 
following conditions:

If the power cord or plug is damaged; if liquid has entered the printer; if the printer 
has been dropped or the case damaged; if the printer does not operate normally or 
exhibits a distinct change in performance. Adjust only those controls that are covered 
by the operating instructions.

Ink Cartridge Safety Instructions

■ Keep ink cartridges out of the reach of children. 

■ Be careful when you handle used ink cartridges; there may be ink remaining around 
the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets 
in your eyes, flush them immediately with water.

■ Do not put your hand inside the printer or touch a cartridge during printing.

■ Do not move the print head by hand. You may damage the printer.

■ Install the ink cartridge immediately after you remove it from its package. Leaving the 
cartridge unpacked for a long time before use can result in reduced print quality.

■ Do not use an ink cartridge beyond the date printed on the cartridge carton. For best 
results, use up the ink cartridges within six months of first installing them.

■ Store ink cartridges in a cool, dark place.

■ Store ink cartridges with the bottom of the packaging facing down.

■ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at 
room temperature for at least three hours before using it.

■ Do not shake an ink cartridge after removing it from its package; this can cause 
leakage.

■ Do not remove or tear the label on an ink cartridge; this can cause leakage.

■ Do not dismantle the ink cartridges or try to refill them. This could damage the print 
head.

■ Do not touch the green IC chip on the front of the cartridge. This may affect normal 
operation and printing.

■ If you remove an ink cartridge for later use, protect the ink supply area from dirt and 
dust and store it in the same environment as the printer. Note that there is a valve in 
the ink supply port, making covers or plugs unnecessary, but care is needed to prevent 
the ink from staining items that the cartridge touches. Do not touch the ink cartridge 
ink supply port or surrounding area.

■ Before transporting the printer, make sure the print head is capped in the far right 
position and the ink cartridges are in place. Secure the ink cartridge holder with the 
included insert to make sure it remains in the proper position.
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FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and 
used in accordance with the instructions, may cause harmful interference to radio or 
television reception. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause interference to radio and television 
reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

■ Reorient or relocate the receiving antenna.

■ Increase the separation between the equipment and receiver.

■ Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected.

■ Consult the dealer or an experienced radio/TV technician for help.

WARNING: The connection of a non-shielded equipment interface cable to this 
equipment will invalidate the FCC Certification of this device and may cause interference 
levels which exceed the limits established by the FCC for this equipment. It is the 
responsibility of the user to obtain and use a shielded equipment interface cable with this 
device. If this equipment has more than one interface connector, do not leave cables 
connected to unused interfaces. Changes or modifications not expressly approved by the 
manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
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Declaration of Conformity

According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/
or CPU Boards and Power Supplies used with Class B Personal Computers:

We: Epson America, Inc. 

Located at: MS: 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254 

Declare under sole responsibility that the product identified herein, complies with 47CFR 
Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is 
identical to the representative unit tested and found to be compliant with the standards. 
Records maintained continue to reflect the equipment being produced can be expected to 
be within the variation accepted, due to quantity production and testing on a statistical 
basis as required by 47CFR §2.909. Operation is subject to the following two conditions: 
(1) this device may not cause harmful interference, and (2) this device must accept any 
interference received, including interference that may cause undesired operation.

Trade Name: Epson

Type of Product: Ink Jet Printer

Model: B251A

ENERGY STAR Compliance

As an ENERGY STAR Partner, Epson has determined that this 
product meets the ENERGY STAR guidelines for energy 
efficiency. The EPA ENERGY STAR office equipment 
program is a voluntary partnership with the computer and 
office equipment industry to promote the introduction of 
energy-efficient personal computers, monitors, printers, fax 
machines, and copiers in an effort to reduce air pollution 
caused by power generation.
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Epson America, Inc. Limited Warranty

What Is Covered: Epson America, Inc. (“Epson”) warrants to the first retail purchaser that 
the Epson printer covered by this limited warranty statement, if purchased and operated 
only in the United States or Canada, conforms to the manufacturer’s specifications and 
will be free from defects in workmanship and materials for a period of one (1) year from 
the date of original purchase. Epson also warrants that the consumable ink cartridges 
enclosed with the printer will perform to the manufacturer’s specified usage, which usage 
may expire before the expiration of the limited warranty for the Epson printer. For 
warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your Epson printer prove defective 
during the warranty period, please call the Epson ConnectionSM at (562) 276-7525 (U.S.) 
or (905) 709-2567 (Canada) for repair instructions and return authorization. An Epson 
service technician will provide telephone diagnostic service to determine whether the 
printer requires service. If service is needed, Epson will, at its option, exchange or repair 
the printer without charge for parts or labor. If Epson authorizes an exchange for the 
defective unit, Epson will ship a replacement printer to you, freight prepaid, so long as you 
use an address in Canada or the U.S. (excluding Puerto Rico and U.S. Possessions). 
Shipments to other locations will be made freight collect. You are responsible for securely 
packaging the defective unit or any requested parts and returning them to Epson within 
five (5) working days of receipt of the replacement. Epson requires a debit or a credit card 
number to secure the cost of the replacement printer in the event that you fail to return the 
defective one. If your printer is being repaired, Epson will direct you to send your printer 
to Epson or its authorized service center, where the printer will be fixed and sent back to 
you. You are responsible for packing the printer and for all costs to and from the Epson 
authorized service center. When warranty service involves the exchange of the printer or a 
part, the item replaced becomes Epson property. The replacement printer or part may be 
new or refurbished to the Epson standard of quality, and, at Epson’s option, may be 
another model of like kind and quality. Epson’s liability for replacement of the covered 
printer will not exceed the original retail selling price of the covered printer. Exchange 
products and parts assume the remaining warranty period of your original product covered 
by this limited warranty.

What This Warranty Does Not Cover: This warranty does not apply to refurbished or 
reconditioned products. This warranty covers only normal use in the United States and 
Canada. This warranty is not transferable. This warranty does not cover any color change 
or fading of prints or reimbursement of materials or services required for reprinting. This 
warranty does not cover damage to the Epson product caused by parts or supplies not 
manufactured, distributed or certified by Epson. This warranty does not cover ribbons, 
ink cartridges or third party parts, components, or peripheral devices added to the Epson 
product after its shipment from Epson, e.g., dealer or user-added boards or components. 
Epson is not responsible for warranty service should the Epson label or logo or the rating 
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label or serial number be removed or should the product fail to be properly maintained or 
fail to function properly as a result of misuse, abuse, improper installation, neglect, 
improper shipping, damage caused by disasters such as fire, flood, and lightning, improper 
electrical current, software problems, interaction with non-Epson products, or service 
other than by an Epson Authorized Servicer. If a claimed defect cannot be identified or 
reproduced, you will be held responsible for the costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN 
LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT 
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, 
NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. SOME 
LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF 
THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE 
LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS 
STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE BY ANY 
OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS 
WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS 
AFFILIATES SHALL BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR 
DAMAGE, INCLUDING DIRECT, SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE OR INABILITY 
TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF 
WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and 
some jurisdictions do not allow the exclusion or limitation of incidental or consequential 
damages, so the above limitations and exclusions may not apply to you. This warranty 
gives you specific legal rights and you may have other rights which vary from jurisdiction 
to jurisdiction. 

Epson America, Inc. - P.O. Box 93012 - Long Beach, CA 90809-3012
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Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or 
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or 
otherwise, without the prior written permission of Seiko Epson Corporation. The information 
contained herein is designed only for use with this Epson product. Epson is not responsible for any 
use of this information as applied to other equipment.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or 
third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result 
of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to 
this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s 
operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any 
options or any consumable products other than those designated as Original Epson Products or 
Epson Approved Products by Seiko Epson Corporation.

Responsible Use of Copyrighted Materials

Digital cameras, scanners, and ink jet printers, like conventional photocopiers and cameras, can be 
misused by improper copying or printing of copyrighted material. While some countries’ laws 
permit limited copying of copyrighted material in certain circumstances, those circumstances may 
not be as broad as some people assume. Epson encourages each user to be responsible and respectful 
of the copyright laws when using digital cameras, scanners, and ink jet printers.

Trademarks

Epson and Epson Stylus are registered trademarks of Seiko Epson Corporation. 

DURABrite and RPM are registered trademarks; Epson Software is a trademark; and SoundAdvice, 
Epson Connection, Epson Print Lab, Epson PhotoCenter, and Epson Store are service marks of 
Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be 
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

The ENERGY STAR emblem does not represent EPA endorsement of any product or service.

© 2004 Epson America, Inc. 3/04
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